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Abstract 

 

Currently, monitoring in agricultural crops represents 

relevance, because there are various applications of the use 

of software and hardware based on the construction and 

adaptation of sensors for automation, based on processes 

of isolation and control of climatological variables that 

seek to minimize risks. This project contributes to the 

improvement of agricultural productivity by offering 

functionality and flexibility in the scenario of precision 

agriculture in the cultivation of C. chinense var. Mayapán 

through the implementation of IoT. To carry out this 

project, an electronic system was designed that consists of 

coupling sensors to measure relative humidity, 

temperature and precipitation, to an ESP32 module and 

subsequently programming it in the Arduino IDE and 

sending it through the internet to a graphical interface in 

the Ubidots platform with the purpose of showing 

information to the user in real time. For the system to 

achieve interaction with the sensors, a Wi-Fi wireless 

connection was used through the MQTT protocol. 

 

 

ESP32, IoT, Ubidots 

 

Resumen  

 

Actualmente el monitoreo en cultivos agrícolas representa 

relevancia, debido a que existen diversas aplicaciones del 

uso de software y hardware basados en la construcción y 

adaptación de sensores para su automatización, basado en 

procesos de aislamiento y control de variables 

climatológicas que buscan minimizar riesgos. Este 

proyecto contribuye al mejoramiento de la productividad 

agrícola ofreciendo funcionalidad y flexibilidad en el 

escenario de la agricultura de precisión en el cultivo de C. 

chinense Var. Mayapán mediante la implementación del 

IoT.  Para llevar a cabo este proyecto se diseñó un sistema 

electrónico que consiste en el acoplamiento de sensores 

para medir la humedad relativa, temperatura y 

precipitaciones, a un módulo ESP32 y posteriormente 

programarlo en el IDE Arduino y enviarlo mediante el 

internet hacia un interfaz gráfico en la plataforma Ubidots 

con la finalidad de mostrar la información al usuario en 

tiempo real. Para que el sistema logre la interacción con 

los sensores, se usó conexión inalámbrica Wi-Fi por medio 

del protocolo MQTT. 
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Introduction 

 

The development of agriculture is one of the 

main economic activities of the State of 

Campeche, it is carried out since ages, however, 

during its work, different parameters have been 

underestimated that currently serve for the 

improvement of techniques and systems applied 

in the agricultural sector to optimise processes 

and improve production.  

 

This paper seeks to propose an 

alternative solution to achieve better production 

with higher crop yields, by optimising resources, 

reducing costs and increasing profitability, in 

order to implement a suitable monitoring system 

with IoT knowledge ensuring precision 

agriculture.  

 

The importance of having a monitoring 

system in the cultivation of C. chinense Var. 

Mayapán is a tool that will allow controlling, 

monitoring and acquiring data in real time 

guaranteeing decision making.   

 

The Internet is a great information tool, 

currently having one of its phases corresponding 

to the Internet of Things (Internet of Things, 

IoT). IoT plays a great role, its application in the 

agricultural sector is of importance where ICT 

tools can be developed and used to ensure 

precision agriculture for better crop management 

and monitoring of variables in order to improve 

production yields, feasibility and environmental 

quality. 

 

Theoretical framework  

 

Traditional agriculture is deficient in yield and 

quality, because it is partially dependent on 

various external factors directly related to 

weather conditions. Currently, there is a large 

amount of information, precision and 

immediacy of data that allow decisions to be 

made at a certain time of cultivation to achieve 

productivity and profitability with the 

implementation of technology (Nuñez-Agurto et 

al., 2020). Technified agriculture has the 

advantage over traditional agriculture, which 

seeks to maximise productivity, product quality 

and is based on the control of variables such as: 

soil, water, humidity, light, wind, temperature, 

among others (Aldape et al., 2022).   

 

 

 

Internet of Things (IoT) 

 

The IoT is an infrastructure with the ability to 

link connections between physical objects, 

processes, internet and people, offering data 

capture and storage, facilitating the sharing of 

information in specific databases in order to 

have control and access to this information from 

any point or location where a person with 

internet access is located (Cortes et al., 2020). 

IoT is driven by the combination of processes 

and methods that employ different sensors, a 

network and an encoding device, which are 

intended to provide an end user with a reliable, 

readable and visual representation of data 

(Montoya et al., 2017). 

 

Precision agriculture  

 

Precision agriculture provides favourable 

solutions that facilitate decision making in the 

improvement of agricultural crops, its 

implementation allows to achieve: efficiency, 

rational use of costs and financial resources, 

higher productivity and yield (Rambauth Ibarra, 

2022). Decision-making based on the use of ICT 

is achieved through monitoring systems with the 

use of digital platforms where IoT presents 

feasible, modern and safe processes (Chanchí-

Golondrino et al., 2022). 

 

Technological progress or modernisation 

nowadays allows obtaining data of interest using 

technified instruments that during this time has 

allowed applications in various areas from the 

development of pest monitoring systems, 

disease diagnosis, management systems, to the 

control and monitoring of climatological 

variables (Bastos Stephens et al., 2022). 

 

MQ Telemetry Transport Network Protocol 

(MQTT) 

 

It stands for Message Queue Telemetry 

Transport. MQTT was created by Dr. Andy 

Stanford-Clark of IBM and Arlen Nipper of 

Arcom in 1999. It functions as a 

publish/subscribe messaging transport where its 

characteristics are: bandwidth efficient, data 

independent, and continuous session 

acknowledgement because it uses a TCP/IP 

stack as the basis for communication; it is an 

open source protocol whose development is 

based on optimising constrained processes and 

low bandwidth, high latency or unreliable 

networks (Burbano-Robles, 2022).  
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ESP32 microcontroller  

 

The ESP32 microcontroller was fundamental for 

its application in this project, which allows 

sending and receiving information from the 

Internet, reading analogue sensors and actuators 

used in the C. chinense Var. Mayapán. 

 

 
 
Figure 1 ESP32 module used in the project 

Source: (MOUSER ELECTRONICS, 2023) 

 

The ESP32 is a System-on-Chip 

designed by Espressif Company and 

manufactured by TSMC. It integrates on a single 

chip a dual-core 32-bit Tensilica Xtensa 

processor at 160 Mhz (with the possibility of up 

to 240 Mhz), WiFi and Bluetooth connectivity. 

In addition, it adds many functions and 

improvements, such as more power, Bluetooth 

4.0, hardware encryption, temperature sensor, 

hall sensor, touch sensor, real time clock (RTC), 

more ports, more buses. 

 

Sensors used  

 

DHT22 sensor  

 

The DHT22 sensor measures temperature and 

relative humidity. Among its components it is 

based on a thermistor for temperature 

measurement and has an internal capacitive 

sensor for humidity, thus being efficient in 

reading simultaneously. 

 
Sensor DHT22 

Model  DTH22 

Operating Voltage  3.3V-6V 

Operating current  2.5 mA 

Output signal  Digital-por Bus de datos  

Sampling rate  0.5 Hz 

RH measuring range  0%RH-100%RH 

Operating temperature -40°C-125°C 

Humidity measurement accuracy  2%-5% 

Temperature measurement range  -40°C-80°C 

Accuracy ±0.5°C-±1°C 

 
Table 1 Technical specifications of DTH22  

Source: (MechatronicStore, 2023) 

 

Sensor PCF-FST-200-201 

 

The wind sensor is easy to mount on different 

measuring instruments, where it can indicate 

values from small wind movements. The 

protection of this sensor ranges from a metal 

alloy to avoid oxidation and the most sensitive 

part is sealed against water and small particles. 

 

 
 
Figure 2 Wind sensor 

Source: (PCE INSTRUMENTS, 2023) 

 

ARD-355 Steren sensor  

 

This sensor has the ability to send its output 

signal digitally or analogically, depending on the 

connection pin used and is adjustable for 

sensitivity. It is compact in size for optimum and 

convenient use.  

 

 
 
Figure 3 Precipitation (rain) sensor 

Source: (Steren, 2023)  

 

Targets  

 

General:  

 

To evaluate the measurement of climatological 

variables on a permanent basis using IoT 

technology in the cultivation of C. chinense Var. 

Mayapán.  
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Specific:  

 

 Obtain the programming of 

microcontrollers for reading 

climatological variables in the Arduino 

IDE.  

 Link the servers with the hardware for 

the monitoring system.  

 Read the sensors connected to the ESP32 

module through the Ubidots platform.   

 

Methodology to be developed 

 

Implementation of the monitoring and 

control system  

 

The sensors are an essential part of the 

monitoring system, so the most accurate sensors 

were chosen for reading the variables connected 

to the ESP32 microcontroller. 

 

 Temperature and relative humidity: 

DHT22  

 Precipitation: Model ARD-355  

 Wind: PCF-FTS-200-201 

 

Diagram of the connections of the ESP32 

microcontroller and the sensors. 

 

The following diagram of the general 

architecture of the IoT monitoring system was 

developed to schematise the different sensors 

that will be linked to the ESP32 microcontroller 

for subsequent constant monitoring through 

devices connected to the Internet. 

 

 
Figure 4 IoT architecture in cultivation of C. chinense 

Var. Mayapán 

Source: Own Elaboration 

Schematic diagram 

 

The diagram of the connection of the different 

sensors with the ESP32 microcontroller was 

made, because the board has different pins with 

multiple functions assigned by default to define 

the properties in the software.  

 

 
 
Figure 5 Schematic diagram of sensors with connection to 

the ESP32 microcontroller  

Source: Own Elaboration 

 

Construction of the prototype 

 

The assembly was carried out by connecting the 

sensors to ground and the signal was connected 

directly to the analogue inputs of the ESP32 

microcontroller to read each one.  

 

ESP32 board configuration  

 

To carry out the configuration within the 

Arduino IDE, we accessed the File > Preferences 

option. It was necessary to locate the section 

URL's Manager > Additional Card and there the 

following link was pasted: 

https://dl.espressif.com/dl/package_esp32.index

.json proceeded to save and give Ok. 

 

Next, go to the Tools tab and click on 

Board > Card Manager. Next, type ESP32 and 

choose the option called Espressif Systems, 

proceed to install and close the window.  

 

Go back to Tools > Board and select 

ESP32 Arduino and select ESP32 Dev Module 

and click on it.  

 

Finally, the Arduino IDE is now 

configured to start working with the ESP32. 

 

Creating an Ubidots account 

 

First, we entered the official Ubidots platform 

and went to the Sing up option.  
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Once we got to this point, we had to 

choose the version of the account we were going 

to work with by selecting For Educational or 

Personal use and correctly selecting "Take me to 

Ubidots stem".  

 

Then the window for registration 

appeared, where it was necessary to add a user 

name, email address and a password, selecting at 

the end the section "My IoT project is for 

personal, non-commercial use".  

 

After logging in with the creation of the 

personal account it is necessary to go to Devices 

> Devices. Here you select to add a blank device. 

It was named under the name "esp.32-cul. -de-

chile".  

 

After having added the device it was 

necessary to start adding the different variables 

to be monitored: temperature, relative humidity, 

wind and precipitation by selecting the option 

Raw and added one after the other.  

 

 
 
Figure 6 Ubidots platform 

Source: Ubidots 

 

Once the variables had been added, the 

user went to the Data > Demonstration panel 

section and then selected add widget.  

 

The widget for each variable to be 

measured was added and configured as required 

for the best visualisation of each one, where 

finally the completed Dashboard (user interface) 

is shown for the control and monitoring of the 

variables.   

 

 
 

Figure 7 Dashboard 

Source: Ubidots 

Link IDE Arduino and Ubidots 

 

The program made in Arduino IDE is divided 

into four files: the main program, configuration 

program, variables definition and the last one the 

configuration pins to be used in the ESP32 

microcontroller.  

 

 
 
Figure 8 Interfacing the ESP32 board file commands to 

the Arduino 

Source: Arduino 

 

First, in the pins file (pinout.h) the 

configuration was made where the GPIO pins 

corresponding to the sensors and actuators were 

added.  

 

Next, the variables definition file 

(credentials.h) was used to configure the 

variables and the names of the variables 

previously defined in Ubidots were added, as 

well as the Ubidots URL, the Ubidots token, the 

Ubidots Client ID, the name of the WI-Fi 

network and the password of the modem to be 

used.  

 

The following file "clientmqtt" contains 

the code that allows the MQTT client to function 

correctly.  

 

 
 
Figure 9 Ubidots interface configured with token and IDE 

Client 

Source: Ubidots 
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We go to the Ubidots platform in the 

Devices section we access the ESP32 

microcontroller and enter variables in order to 

copy and paste the name of the variables in the 

variables configuration file found in the Arduino 

IDE where the program was compiled and 

downloaded to the ESP32 card, at that time the 

card already has the program that when turned 

on is capturing the information from the sensors. 

The information is sent by WiFi to the modem, 

which looks for the Ubidots page that was 

previously configured the token and the IDE 

Client of the platform.  

 

Immediately we proceeded to open the 

Ubidots platform with our username and 

password registration, we access the Data 

section followed by Dashboard where you can 

finally have access graphically and allows easy 

way to monitor the variables in a friendly way.  

 

Results 

 

In order to carry out the corresponding 

operational tests, the sensors were connected to 

the ESP32 module for the visualisation of the 

operation, as well as the communication link 

between the client and the server.  

 

 
 
Figure 10 Client communication with the MQTT server  

Source: Ubidots  

 

It was possible to determine the results 

thanks to the communication of the ESP32 

module with the client for the observation of the 

readings of the values indicated by the different 

sensors used in the monitoring system working 

correctly and in the best way suitable for the 

visualisation in the graphic interface with the 

widgets of each climatological variable for its 

monitoring in the Ubidots platform in real time. 

 

 

 
 
Figure 11 Logging of sensor readings from the monitoring 

system on the Ubidots platform 

Source: Own Elaboration 

 

Finally, the server allows and facilitates 

the registration of the readings during the period 

of time estimated by the user within the platform 

in a precise manner, establishing the day, time 

and value of the variables being measured.  
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Conclusions 

 

The development of the prototype worked 

correctly by achieving the communication of the 

ESP32 module with the Ubidots platform using 

a client with MQTT protocol to create a graphic 

interface for the real-time visualisation of the 

reading of the different sensors for the 

monitoring system of climatological variables in 

the cultivation of C. chinense Var. Mayapán.  

The system presented great relevance after 

achieving the ability to carry out remote 

monitoring from anywhere with a device with 

Internet access. 
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It is concluded that the transition of the 

Internet, reaching the 4.0 phase corresponding to 

IoT, seeks to consolidate as a tool in different 

areas such as informatics, agricultural 

innovation, biochemistry and mechatronics. The 

growing interest and need to understand how the 

effects of climate change impact agricultural 

crops in the physiological development of plants 

and morphological characteristics that occur 

leads us to make the implementation of advances 

in technology with various solution platforms 

applied to engineering for the creation of visual 

interfaces to establish communication with 

devices with Internet access. 
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